Using Mail Merge to Print Spine Labels from Evergreen

These instructions are to print spine labels on label stock for laser or desk jet printers using Mail
Merge in MS Word 2010. The initial set-up in Mail Merge is time consuming; however, you can
save the file and not have those steps every time. These instructions assume familiarity with
Evergreen spine label printing functionality and do not fully illustrate those steps.

Creating a spine label file in Evergreen 2.1
Populate Item Status (F5) with barcodes of items needing spine labels. You can do this by:

e Scanning barcodes directly into Item Status (F5).
e Uploading a file of barcodes created from a report.
e Transferring from an Item Bucket.

Whichever method you use, make sure Trim List box is unchecked. If you have nonstandard
barcodes, make sure Strict Barcode is unchecked.

Highlight all entries.

Right click or choose Actions for Catalogers or Actions for Selected Items then, Print Spine
Labels.

It may take a few moments for a large file to open in the Print Spine Label interface.

Make sure your settings are correct and that Pocket Labels are not Enabled. Re-generate if you
make any changes.

Click on the Preview and Print button.

Click somewhere in the white space of the printing preview screen, then press CTRL+A to
highlight the entire group and then CTRL+C to copy.

Setting up a spine label file in MSWord 2010
Open MSWord.
Paste file of call numbers copied from Evergreen’s spine label preview screen.

Select all either using CTRL+A or Select, then Select All:
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With the contents highlighted, go to the Insert tab, Table, Convert Text to Table:
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Make sure Paragraphs under Separate text at is selected and change the number of columns to
an appropriate number (This should conform to the number of lines set in Label Length in the
Evergreen Spine Label Printing interface.):
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Your file will now look something like this:

MEL®E 20068 - H H 5] H
EH 362,298 ENCxH 2001x= V.ln H H
EH 362,298 ENCH 2001x= V.2u H H
JH 613.85m EVLHE 2009= H H =4
JH 641.84n BLLHE 2009= H H =4
En EDW= 2009= o u u -
070,45 KIN= 2010= o n n -1
BH 394,26 HATH H =3 H n
OWD® 970H TRLE 200%8= 4 H H
OWD® COoWs= 2008= V.22H 4 H H
DWDH COW= 2008= V.10H fd H H
DWDx COWn 2008= V.o= H H =4
DWDx COWn 2008= V.8n H H =4
DWDx COWn 2008= V.TH H H =4
DWDx COWR 2008= V.6x H H =4
DWDx COWR 2008= V.Em H H =4
OWDE COWn 2008= V.4H H H H
OWDE COWn 2008H V.38 H H H
OWDE COWn 2008= V.28 H H H
OWDE COWn 2008= V.24H H H H
DWDx CowW= 2008= V.23 H H H
DWDx COWn 2008%= V.21= H H =4
DWDx COWn 2008= V.20 H H =4
DWDx COWn 2008%= V.19 H H =4
OWDE COWH 2008= V.18H H H H
OWDE COWH 2008= V.17H H H H
OWDE COWH 2008= V.1eH H H H
OWDE COWH 2008= V.15= H H H
OWDE COWn 2008= V.14H H H H
DWDx CowW= 2008= V.13 H H H
DWDx CowW= 2008= V.1z2= H H H
DWDx CowW= 2008= V.11= H H H
DWDH CowW= 2008= V.1= H H H
Bu 382n NCE= 1997= H H H
Bu 423n OFF= 1933= H H H

u S11x OLTxE b= b= -1 b=3

Insert an empty row at the top of the table:
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Make any format changes to your call numbers and delete blank columns.
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Save the document. Remember what you named it and where you saved it. You can save over
any file used previously or give it a new name each time.

Setting up Mail Merge in MS Word

Open a new MSWord document.

Go to Mailings, Start Mail Merge, and then Labels:
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Set up your labels, based on the stock you are using, in New Labels. For example:

Label Options Label Details B

Printer information Preview
() Continuous-feed printers Side margins
(@ Page printers Tray: Stack Bypass Top margin

Label information

Label vendors: | Other/Custom E Vertical pitch
Find updates on Office.com
Product number:
1D striES - —Mumber across
Label name: spine label test
= || | Top margin: 01" = Label height: 1.5" =
Details.. l [ New Label... J ’ Delete Side margin: 0.1 = Label width: 1 =
L Vertical pitch: 1.5" = Mumber gcross: 3 =
Horizontal pitch: 1" = Mumber dawn: 7 =
Page size: Letter (8 ¥2x 11in) E
Page width: 8.5" - Page Height: 11" -
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Click on OK when you are done. Once you set up the stock you will see the name in the Label
Options window under Other/Custom:

-

Label Options

=X

Frinter information

() Continuous-feed printers

(@ Page printers Tray: |Stack Bypass IZI
Label information
Label vendors: | Other/Custom Izl

Find updates on Office, com

Product number:

Details. .. ] [ﬂew Label... ] [ Delete

Label information

D striEs - Type: Custom laser
Height: 1.5"
Width: 1"

Page size; 8.5" = 117

Clicking on OK loads the labels.

Next, you want to load the call number file you saved previously. From Select Recipients

choose Use Existing List:
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Your file will now look similar to:

[

Iﬂ w«MNext: w«MNext- “Mext: “Mext- “«Mext- aMNext- aMNext- "
3] Record=9 Record»9 Record»9 Record»9 Record»9 Record=9 Record=1)

o] o] o] o] [} [+ [+
aMext: wMNext: wMNext: wMNext: wMNext: wMNext wMNext: wMNext: "
Record»1] Record»1] Record»1] Record»1] Record»1] Record»1] Recordn»f] Record»q]
o o o o o o o o
wMext: whext: whext wMext- wMext- «Mext- «Mext- «Mext- "
Record»1] Record»9] Record»q] Record»q] Record»q] Record»q] Record»q] Record»v]
o o o [+ [+ [ [ [
aMNext- w«MNext: wMNext- “«Mext- “Mext- “«Mext- aMNext- aMNext- "
Record»1] Record»1] Record»1] Record»1] Record»1] Record»1] Record=v] Record»q]
2] o] o] o] o] o [+ [+

Next, from Insert Merge Field, insert each AutoMergeField listed. The number present will be
the number of columns in your saved document.

; Mailings Review WView Acrobat Design il

j j | ] =P Rules -
= = =1 @3 Match Fields
Address Greetinghnsert Mvarge|

Block  Line Field» | 2] Update Labels
Write & In AutoMergeField
i IS N AutoMergeFieldl ' ' |
AutoMergeField2
wMext: whe: wMext:
AutobMergeField3
Record=»9 Recc Record
o o AutoMergeFieldd o
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Once they are added, your file will now look similar to this:

o

«hAutohMe wMext: wMext: wll
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Highlight the whole document by highlighting the rows of the table at the top. The gold Table
Tools tab will appear when you have it highlighted correctly:
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Click the Home Tab. And go to Change Styles:
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From there, go to Paragraph Spacing and then No Paragraph Space:
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3. Replace
eading 2 Title subtitle | _ |Change
T || Styles = by Select -
yles I Style Set »
B KNS ngnlnrs .
i 1] Fonts b
q Built-In ;ﬂ; Paragraph 5pacing ¥
[=
|==|| Mo Paragraph Space set as Default
l_ﬁ
[S=| Compact
= )
pmed | Tirnkt

You may have to make changes under Custom Paragraph Spacing if too much space is between
the lines in your document:
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You can also choose the font and size you want to use from the Change Styles area:
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Once you have made your changes, Return to the Table Tools tab and click on Layout and

choose Align Center Left:

Design Layout
| Height: 1.5° : | Bfpistribute Rows =233 & %l
H =t == = Text Cell Sort
[; Width: 1° : Distribute Columns e = a
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Click inside the first label at the end of the last AutoMergeField (you may have to enlarge the
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Press the delete key to take out the last blank row.

whAutoiMe
rgeField»
«AutoMe
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Now move the cursor in between each of the AutoMergeFields and press Enter:
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Your label should look similar to this:
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«AutoMe
rgeFieldl
»1]
whAutoMe
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»q]
«AutoMe
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Click back on the Mailings tab and then Update Labels. Your labels should now look like similar

to this:
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«AutoMe AutoMerg AutoMerg AutoMerg AutoMerg AutoMerg AutoMerg AutoMerg
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EL Il «AutoMe «AutoMe «AutoMe wAutoMe «AutoMe wAutoMe «AutoMe
«AutoMe rgeFieldl rgeFieldl rgeFieldl rgeFieldl rgeFieldl rgeFieldl rgeFieldl
rgeField2 »q] »q] »1] »A] »1] »q] »1q]
EL Il «Autohe «AutoMe «AutoMe «AutoMe «AutoMe «AutoMe «AutohMe
«AutoMe rgeField2 rgeField2 rgeField2 rgeField2 rgeField2 rgeField2 rgeField2
rgeFields »q »q »q] »] L LI »q]
kLIl «AutoMe «AutoMe «AutoMe wAutoMe «AutoMe wAutoMe wAutoMe
RAGTaRe rgeField3 rgeField3 rgeField3 rgeField3 rgeField3 rgeField3 rgeField3
rgeFie|d4 »q] »q] »q] »q] »q »q] »q]
o «hutoMe «AutoMe «AutoMe whutoMe «AutoMe «AutoMe «AutoMe
«Next- «Next- «Next- «Next- «Next- «Next- «Next- «Next-
Recordw« Recordw« Recordw« Recordn Recordn« Recordn« Record»« Record»«
AutoMerg AutoMerg AutoMerg AutoMerg AutoMerg AutoMerg AutoMerg AutoMerg
eField»q eField»q eField»q eField»1 eField»1 eField»1 eField»1] eField»9
«AutohMe «AutoiMe «AutoMe «AutoMe «AutoMe «AutoMe «AutoMe «AutoMe
rgeFieldl rgeFieldl rgeFieldl rgeFieldl rgeFieldl rgeFieldl rgeFieldl rgeFieldl
»q] »q] »q] »1] »1] »f] »q] »q]
«Next- «Next- «Next- «Next- «Next- «Next- «Next- wNext-
Record»« Record»« Record»« Record»« Record»« Record»« Record»« Record»«
AutoMerg AutoMerg AutoMerg AutoMerg AutoMerg AutoMerg AutoMerg AutoMerg
eField»q eField»q eField»q eField»1] eField»1 eField»1 eField»1] eField»q]
«AutoMe «AutoMe «AutoMe «AutoMe wAutoMe «AutoMe «AutoMe «AutoMe
rgeFieldl rgeFieldl rgeFieldl rgeFieldl rgeFieldl rgeFieldl rgeFieldl rgeFieldl
»q] »q] »q] »q] »q] »q »q] »q]
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Click Preview Labels to view all your labels:

ut References Mailings Review View Acrobat I Design Layout I
a % % @ [Zr Rules ~ H 41 koM Q
— - — == @5 Match Fields  Find Recipient e :
Edit Highlight Address Greeting Insert Merge Preview Finish & | Merge to
Recipient List | Merge Fields Block  Line Field~ (2] Update Labels | |Results| S Auto CheckforErrors | Merge~ | Adobe PDF
ge Write & Insert Fields Preview Results Finish Acrobat
- e SRR TERNEEES TEENEEES SRR TN RS SRR
MALSY RAl RAl 1M M Eq 070.49 R1l "
20069 362.299 362.299 613.859 641.849 EDWY] KINY] 394.29
;il ENCY] ENCY] EVASY] BLAY qZIL'IL'IEH] i_‘lﬂlll!] :—:AT“
20019 20019 20099 20099 . o .
V.lg V.20 u u
DVDY DVDe DvDe DVDY DvDY DvDq DVDY DVDY "
9709 cowe coweq CowY CowY Cow9 Cowe Cowe
TRAY] 20089 20089 20089 20089 20089 20089 20089
20099 V.229 V109 V.99 V.89 V.79 V.69 V.51
o o o o] o] o] o] o]
DvDY DvDe DvDe DvDY DvDY DvDY VDY DvDe "
cowe cowe cowe cowy cowe cowe cowe cowe
20089 20089 20089 20089 20089 20089 20089 20089
V.49 V.39 V.29 V.249 V.239] v.219] V.209 V.19
o 0 0 5] 5] 4] 4] 4]
DVDe DVDe DVDY DVDY DvDe DvDq DVDY DVDY "
cowe cowe cowe cowe cowe cowe cowe cowe
20089 20089 20089 20089 20089 20089 20089 20089
V.189 V179 V169 V.159 V.149] V.139 V.129 V.119q
o o o o] o] 1] o] o]
DVDy R R R Rl RYl Rl RY !

If no formatting or other changes need to be made to the labels, you are ready to print. Under
Mailings, go to Finish & Merge, then Print Documents:

gn Layout
M 41 > M =
I
Merge to
; 2, Auto Check for Errors Adobe POF
e L £3 Editindividual Documents... ||
IS DD IO | L33 Print Documents...
&"i’ Send E-mail Messages...
Ll Efl 070 .= T :
[£41 240 ENWAE KING ___2a1 7@ i
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A dialog box will open allowing you to print the entire file or individual records (call numbers).
Choose All and then OK. You can then choose your printer and print.

If you need to make changes to any of the call numbers, click Finish & Merge and then Edit
Individual Documents, All:

T

by
Finish & Merge to
Errors Merge || Adobe PDF

i:._‘l Edit Individual Documents...
Z - - L;,g Print Documents..,
B

Send E-mail Messages...

Lo |

070 %]
KING 394.29)
2010 HATH)
1 1

[+ [+

A new screen will open with an editable version of your call number file. After you have made
your edits, print from the File tab:

Home Insert Page Layout References Mailings Review View Acrobat Design Li
= save
Print
E Save As @
E Copies: 1 - MAL R
.| Save as Adobe PDF . 2006 362.29
Print .
5 Open ENC
. . 2001
rinter
&' Close Vi
9 _/C 6570 PS3 on TREVOR
Info w anon on -
2, Ready ovD VD
Recent Printer Properties 970 cow
TRA 2008
New Settings 2008 v
L Print All Pages .
_ ) Print the entire document
ovD VD
Pages: i
Save & Send cow cow
| Print One Sided . 2008 2008
Help 1 Only print on one side of the page V4 V3
= Collated
] Options = ul_.z_a 123 123
Q Exit o ovD VD
=3 Mo Staples - cow COW
2008 2008
j Portrait Orientation - V.18 V.17

Close that window after printing and go back to the Mail Merge file and save it. Saving the file
allows you to re-use the formatting steps, so remember the name and where you saved it.

14
Spine label printing with Mail Merge
September 2012



Printing spine labels once Mail Merge is set-up

Once you have set-up and saved the Mail Merge file in MSWord 2010, you can re-use it to print
subsequent labels so that you do not have to go through the laborious set up each time. You do
have to set up the label file in Evergreen and MS Word following the instructions in the sections
“Creating a Spine Label File in Evergreen” and “Setting up a spine label file in MSWord 2010” It
is very important to use the same number of columns as in your first file in each of your
subsequent files to prevent problems with auto merge fields in Mail Merge.

Open MSWord and the file for Mail Merge you saved earlier. A dialog box warning you that the
SQL commands for the Mail Merge will run on the file will open. Click Yes:

Microsoft Word |

Opening this document will run the following SQL command:

l ,  SELECT *FROM P:\PINES\Evergreen'Spine label printingTesting mail merge\spine pocket label test sept 20.docx

Data from your database will be placed in the document, Do you want to continue?

Show Help ==

Was this information helpful?
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Your formatted file will open:

I."‘I U | M - At - At N Mt N Mt N L N L N Lo
MaLg RY) RY 19 19 Eq 070.49 RY "
20061 362.291 362.291 £13.851] 541.844) EDWY KINY 394.29
1 ENCH ENCY EVAY BLAY 20094 20109 HATY
ol Ll L] L]

20019 20014 20099 20099 5 5 .
V.1H V.20 H ol
ovDYy DVDY oVDY ovDe DVDe DVDe DVDe DVDe H
9709 COWY COW9 COW1 Cowq cCowq cowq cowe
TRAY 20084 20084 20084 20084 20084 20089 20089
20099 V.229) V.109 V.91 V.81 V.7 V.61 V.59
2] o] o] o] o [+ [+ [+
ovDYy ovDY ovVDY ovDe DVDe ovVDe oVDe ovVDe "
COWe COWe COWe COW Cowe cowe cowe cowe
20089 20089 20089 20089 20089 20089 20089 20089
V.41 V.39 V.21 V.249 V.239 V.219 V.209 V.199
] ] =] =] [ o o o
ovDY ovDY DVDY DvVDY DVDA DvVDA DvVDA ovVD "
COW1 COW1 COW™ COW™ Cowq cowq cowq cowe
20089 20089 20089 20089 20089 20089 20089 20089
V.189 V.79 V.169 V.159 V149 V.139 V.129 V.19
[+ [+ 4] 4] 4] o 4] o
DVDY RY] Rl R R Rel R1 RY .

Next, open your current call number file. Under Select Recipients, go to Use Existing List and
choose your file:

e e TS T T ST Y T |

Insert Page Layout References Mailings Review View Acrobat Design
='51. 8 ;_'q ;j éj E =P Rules ~
' ' ' — oy Match Fields
art Mail Select Edit Highlight Address Greeting Insert Merge
Nerge = |Recipients =|Recipient List | Merge Fields Block Line Field = |#] Update Labels
(=== Type Mew List... Write & Insert Fields
Use Existing List... \ - - - F - o F 1 F
fi=| Select from Cutlook Contacts...
R Y Rl LI\ LI
20069 362,299 362,299 613.859) 64
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It will open looking similar to this:

e
hAutOMe «Next- «Next- wMext «Mext “Next- aNext aNext "
rgeField»9) Record»« Record»« Record»« Record»« Record»u Record»« Record»«
«AutoMe AutoMerg AutoMerg AutoMerg AutoMerg AutoMerg AutoMerg AutoMerg
rgeFieldl eField»q eField»q eField»q eField»q eField»q] eField»q] eField»q]
»q] whAutoMe «hAutoMe «AutoMe «AutoMe whAutoMe «AutoMe «AutoMe
«AutoMe rgeField1 rgeFieldl rgeFieldl rgeFieldl rgeFieldl rgeFieldl rgeFieldl
reeField2 Ll Ll Ll Ll »q »q »q
«Next- «Next- «Next- «Next- «Next- «Next: «Next: «Next- "
Record»« Record»« Record»« Record»« Record»« Record»« Record»« Record»«
AutoMerg AutoMerg AutoMerg AutoMerg AutoMerg AutoMerg AutoMerg AutoMerg
eFicld»q eField»q eField»9q eField»q eField»9q eField»q eField»q eField»q
«AutoMe «AutoMe «AutoMe «AutoMe «AutoMe «AutoMe «AutoMe «AutoMe
rgeFieldl rgeFieldl rgeFieldl rgeFieldl rgeFieldl rgeFieldl rgeFieldl rgeFieldl
»q] »q »q »q »q »q] »q] »q]
«Next- «MNext- «MNext- «MNext «MNext «Next «Next- «Next- "
Record»« Record»« Record»« Record»« Record»« Record»« Record»« Record»«
AutoMerg AutoMerg AutoMerg AutoMerg AutoMerg AutoMerg AutoMerg AutoMerg
eField»q eField»q eField»f eField»f eField»f eField»q eField»q eField»q
«AutoMe «AutoMe «AutoMe «AutoMe «AutoMe «AutoMe «AutoMe «AutoMe
rgeFieldl rgeFieldl rgeFieldl rgeFieldl rgeFieldl rgeFieldl rgeFieldl rgeFieldl
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